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BACKGROUND
Obtaining accurate and timely traffic data is essential to successful transportation

operations/planning projects. Several methods of collecting traffic data are available, which
range from manual counts by field personnel, to using different technologies designed
specifically for data collection (such as road tubes, video detection, induction loops, radar, etc.).
Traffic detection technologies can generally be classified into two groups: intrusive and non-
intrusive. Intrusive detection technologies are installed on/within the roadway. These
installations require lane closures, which disrupt traffic flow and increase vehicle-personnel
interactions. Using this type of technology is inherently more hazardous and is generally more
time consuming, especially for temporary traffic data collection. Non-intrusive traffic detection
technologies are deployed adjacent to the roadway and require minimal (if any) interaction with
traffic flow. These types of detection technologies do not require any lane closures, which
results in a safer environment.

Several studies have been performed comparing different types of non-intrusive technologies.
Radar based detection devices have consistently scored the highest in accuracy, cost-
effectiveness, and installation/use [1, 2, 3]. The Advanced Traffic Analysis Center (ATAC) has
acquired several radar-based traffic detectors and will evaluate their performance for the North
Dakota Department of Transportation (NDDOT), specifically for use as temporary data collection
devices.

STUDY OBJECTIVES
The main objective of this study is to determine the applicability of using radar-based sensors to

support the NDDOT traffic data collection efforts. These sensors would be used primarily as
temporary, portable data collection devices, so ideally they would be deployed with minimal
resources.

During the study, the sensors will be evaluated for accuracy in providing volumes, speed, and
classification using two types of mounting methods. The first method consists of a tripod-based
system which was designed and built by ATAC staff. The second method consists of mounting
the sensors to an existing sign structure.

This study will also provide documentation on setting up and calibrating each of the sensors to
improve accuracy. The configuration and calibration guides for each sensor are located in
Appendix A. During the study’s kick-off meeting on June 17, 2008, the format of the sensors’
output files was a concern for the NDDOT. Currently, all of NDDOT's traffic data are stored as a
.PRN file type, which has a much different format than the sensor output files. As a result, this
study also will develop an Excel spreadsheet to converts each of the sensor outputs into the
.PRN format.

RADAR SENSORS
Radar sensors operate by focusing a radar beam primarily perpendicular to the roadway, and

detecting the reflection from vehicles as they pass through the beam. The radar beam tries to
emulate an inductive loop by detecting the presence, size, and speed of vehicles. Since the
detector only sees the signature of the vehicles passing through its beam, it bases the
classification on the length of the vehicle being detected.
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Several benefits exist for using radar for traffic detection. Radar sensors are relatively easy to
set up and operate, and they have been shown to be among the most accurate non-intrusive
vehicle detection technologies. Another benefit of radar sensors is that they can be deployed
alongside the roadway, allowing them to be used in a safe environment.

The radar sensors used in this study are among the most commonly used radar-based sensors
available (manufactured by Wavetronix and Electronic Integrated Systems (EIS)) and use
frequency modulated continuous wave (FMCW) radar technology. Both companies have been
in existence for several years, and are continually improving their devices. Some commonalities
exist among the different sensors, such as being powered by 12-volt marine deep-cycle
batteries, and communicating through a RS-232 serial port. The following sections provide
more detail on the sensors that will be used in this study. Figure 1 shows each of the sensors
used in this study, which are mounted using the tripod structures.
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Figure 1. Radar Sensors on the Tripod Mounting System

Wavetronix SmartSensor 105
The SmartSensor 105 is the first-generation radar sensor developed by Wavetronix. The

SmartSensor has a range of 200 feet (ft) and collects traffic volume, speed, occupancy, and
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classification for up to 8 lanes of traffic. Vehicle classification is user-defined and can be divided
into three length-based classes. Speed data collected by the SmartSensor is a running average
of 16 vehicles, independent of the time period. The speeds are recorded at the end of each
data interval and are stored accordingly. The SmartSensor is capable of collecting data on a
lane-by-lane basis, providing directional volumes, classifications, and speeds.

The SmartSensor can be operated from a side-fire position, which allows for a safe and
relatively quick deployment. This sensor has an “auto-calibration,” which detects passing cars
and assigns the respective lanes. The SmartSensor has an internal data storage capacity of
2,976 time intervals, with a minimum time interval of five seconds.

Wavetronix SmartSensor HD (125)
The SmartSensor HD is the upgraded version of the SmartSensor 105. It has a range of 250 ft

and is capable of detecting up to 10 lanes of traffic. The SmartSensor HD collects traffic
volume, individual vehicle speed, average and 85" percentile speed, average headway and
gap, occupancy, classification, and presence.

Similar to the SmartSensor 105, the SmartSensor HD can be operated from a side-fired
position, and has an “auto-calibration” configuration process. The vehicle classification of the
SmartSensor HD is capable of 8 length-based classes which are user-defined. All of the power
and connection/communication requirements are the same as the SmartSensor 105, which
allows existing conditions to be upgraded.

RTMS
The Remote Traffic Microwave Sensor (RTMS) is a data collection device which was developed

by Electronic Integrated Systems (EIS). The RTMS is similar to the SmartSensor in that it can
be configured to a side-fired mode, and collects data by using a radar beam and detecting the
reflections of passing vehicles.

The RTMS is capable of detecting up to 8 lanes of traffic, and has a range of 200 ft. It collects
data on vehicle volume, speed, occupancy and classification of 2, 4, or 6 length-based vehicle
classes. It has an external memory with a capacity of 4.125 MB, and can store up to 61,000
intervals with time intervals ranging from 10 seconds to 600 seconds.

The main installation requirement of a radar sensor relates to the sensor’s offset from the first
lane of travel. The allowable offset (same as clear zone) corresponds to a recommended
mounting height. To optimize the accuracy of the sensors, each vendor provides recommended
height-offset requirements (Table 1).
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Table 1. Sensor Height/Offset Requirements

Offset From First Recommended Mounting Height (ft)

Detection Lane (ft) SS105 SS125 RTMS
5 - - 17
6 - 16 17
7 - 16 17
8 - 16 17
9 - 16 17
10 12 16 17
11 12 16 17
12 13 17 17
13 13 17 17
14 14 18 17
15 15 20 17
16 15 20 17
17 16 21 17
18 17 22 17
19 17 22 17
20 18 23 17
21 18 23 17.6
22 18 23 18.2
23 19 25 18.8
24 19 25 194
25 20 26 20
26 20 26 20.6
27 21 27 21.2
28 21 27 21.8
29 21 27 22.4
30 22 29 23
31 22 29 23.6
32 22 29 24.2
33 23 30 24.8
34 23 30 25.4
35 23 30 26
36 23 30 26.6
37 23 30 27.2
38 24 31 27.8
39 24 31 28.4
40 25 33 29
41 25 33 29.6
42 26 34 30
43 26 34 30
44 27 35 30
45 27 35 30
46 28 36 30
47 28 36 30
48 29 38 30
49 29 38 30
50 30 39 30

Note: Shaded area represents the recommended height/offset

RADAR MOUNTING SYSTEMS
ATAC constructed five tripod towers for temporary data collection. Each tower includes a built-

in storage compartment for the power supply (12-volt marine deep-cycle battery). The entire
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structure can be set up and taken down in approximately 15 minutes, and all of the components
are small enough to be stored in a 6 ft (width) by 10 ft (length) cargo trailer. The approximate
cost of each tower is $2,000, which will vary depending on the price/availability of materials and
the time required for construction. The maximum height of this mounting system is
approximately 39 feet.

The second mounting method evaluated was a sign-mount system. This method provides a
cheaper and simpler method for using the radar sensors. The sign-mount system consists of
poles that are banded to existing sign structures. The approximate cost for this system is $600
each, which will provide a mounting height of approximately 39 feet.

METHODOLOGY

Temporary traffic data collection is difficult to obtain for freeway facilities. Therefore, this study
will focus on a freeway segment. In addition, the case study location has to be a high-traffic
area so sufficient data can be used for the study.

After a suitable location is selected, the sensors will be set up according to their respective user

manuals. Once the sensors have gone through their ‘auto-calibration’ process, fine-tuning will
be done by observing traffic flows and adjusting the detection zones as necessary. Speed data
will be calibrated with hand-held radar, and adjustments will be made to the sensors when
needed.

It is desired to have the sensor’s speed data within 2-3 mph of the hand-held radar. The
measures of effectiveness (MOE) for this study are a comparison of the volume, speed, and
classification data for each sensor. The data for each sensor will be compared to manually
collected data. This comparison will assess the performance of each sensor in a temporary,
remote deployment as an alternative to conventional data collection technologies. Comparisons
will be made on a lane, direction, and total roadway cross-section.

After all three sensors are set up and operating, the Traffic Data Collection System (TDCS) will
be deployed for the manual verification. The TDCS is a video surveillance trailer consisting of a
6 ft (width) by 10 ft (length) cargo trailer which houses a 42 ft telescopic, pneumatic mast. Two
pan-tilt-zoom (PTZ) cameras can be mounted to the top of the mast, and are connected to a
video recording system inside the trailer. The location of the TDCS (200 ft behind the sensors)
will allow for a clear view of the sensors and the passing vehicles.

Each of the radar sensors had different capabilities related to vehicle classification. Therefore,
several vehicle length classes were developed based on research done by various
transportation agencies (as shown in Figure 2). Based on this data, the following four vehicle
classification bins were used:

Motorcycles (0 — 10) ft
Passenger Cars (0 — 20) ft
Single-Unit Trucks (0 — 55) ft
Tractor-Trailer Trucks (> 55) ft

P wnNpP
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Figure 2. Vehicle Classification Length Ranges (sources 4-9)
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The study location also includes an existing Automatic Traffic Recorder (ATR), which uses a
series of inductive loops to collect data on volume, speed, and vehicle classification. To provide
a comparison to technologies currently being used, the data from the ATR will also be
compared with the radar sensor data. It should be noted that the ATR’s classification loop in the
NB lane 3 was damaged before this study took place. The loop was classifying vehicles by
length, rather than by number of axles, which may have had an effect on the accuracy of the
data collected in this lane.

CASE STUDY
The location chosen for this study was Interstate-29 (I-29) south of 19" Ave. N. (Fargo, ND),

which is shown in Figure 3. This section of freeway consists of six lanes, and has a speed limit
of 55 mph. The average daily traffic (ADT) at this location was 26,000 when counted in 2006.

‘ ' | r Legend

1 2 3 s—Lane H—» 3 2 1 . Vehicle Classification Marker
Southbound Northbound ,L Sensor Tripod
[T [T |

Figure 3. Case Study Location

This location provided easy access to the right-of-way on the east side of the interstate, and
was adjacent to a field where the TDCS could be deployed. This site was also the location of
an existing ATR data collection system, which was installed during the reconstruction of I1-29. In
addition, there were several roadway signs in the vicinity, which could be used as sensor
mounts. The sensors were set up on July 25, 2008, with a 50 ft offset from the roadway to
maintain a safe clear zone.

Sensor Calibration

Most of the sensors allow users to perform speed calibration. The calibration procedures varied
greatly among the three sensors, with the SmartSensor 105 being the most time-consuming.
The speed calibration for the SmartSensor 105 required taking speed readings for each lane
and adjusting the sensor’s value up or down depending on the speed error. This was an
iterative process and required several attempts to produce accurate vehicle detection (Figure 4).
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The initial lane speed sensor values (default of 1.0) produced higher than desired speeds, which
required the sensor values to be adjusted. All of the sensor speed values had to be lowered,
and overall the southbound speed values were higher than the northbound values with the
exception of the northbound lane 2. The calibrated parameters produced speeds that were
within 3-4 mph per lane. It should be noted that the actual calibration process depends heavily
on the amount of traffic present.

Sensor Values for Speed Calibration
1.05
1.00 0 :
\ ¢ ¢
E —=—S5B2
E 0.90 L..__________. SB3
5 . —<—NB3
? 085 —NB2
NB1
0.80
0.75
Initial Setup Iteration 1 Iteration 2 Iteration3 Iteration4 Iteration 5

Figure 4. SmartSensor 105 Speed Calibration

Detection Comparison Procedures
To assist in the vehicle classification evaluation, cones were set up alongside each direction of

the interstate to serve as visual aids for the manual vehicle length classification. The cones
were initially set at (0, 10, 18, and 55 ft). Upon analysis, it was apparent that an adjustment
needed to be made to the passenger car vehicle lengths, and it was changed to 20 ft. This was
due to under-counting passenger cars and over-counting single-unit trucks. It was observed
that several large passenger vehicles are longer than 18 ft.

The duration of each comparison study was approximately one hour. This was done to keep
the amount of data at a manageable level while maintaining a sufficient sample size of vehicles.
Once the data was downloaded from the sensors, it was compared with the post-processed
video data. Data from the ATR during the same time period was also collected to illustrate the
comparison between the sensors and inductive loops.

The second phase of this study evaluated sensor accuracy using a sign-mounted method. This
was done by using the pole from a tripod and fixing it to the sign structure with metal banding
(Figure 5). The offset from the roadway was the same, so no adjustments had to be made to
the height. This method of mounting is fairly straightforward, and easy to set up.
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Figure 5. Sign-Mounted Sensors

RESULTS

Several different comparisons were conducted for this study, which include volume, speed, and
vehicle classification. In addition to the comparison among the three sensors, comparisons
were also done using data from the ATR, and from the alternative sign mounting of both
SmartSensors. The following section describes the results of the study.

Traffic Volume

The volume data from each comparison was organized into lane volume, directional volume,
and total volume (combined NB and SB). Overall, the SmartSensor HD was the most accurate
for vehicle volumes, and had comparable results to the ATR. However, there was one instance
that the sensor appeared to be malfunctioning, which can be seen in the over-counted volumes
for October 14, 2008. After this was noticed, the sensor was restarted and it functioned
normally. For the remainder of this study, the results of the SmartSensor HD will not include
this day, but are shown in the summary tables. It should be noted that with the exception of a
few instances, all of the volume discrepancies were a result of the sensors over-counting the
vehicles.

The SmartSensor HD lane volume differed from the manual counts with a range of -3% to 5%
(Table 2). The sign-mounted SmartSensor HD accuracy was slightly worse, having differences
ranging from -9% to 15% when compared to the manual count. The RTMS showed differences
ranging from -10% to 26%. The SmartSensor 105 was the least accurate, with differences
ranging from -8% to 31%. The sign-mounted SmartSensor 105 had differences of -12% to 26%,
which was a similar range to the tripod-mounted sensor.
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Table 2. Lane Volume Comparison

Manual SS 105 SS HD RTMS ATR SSHD S.M. | SS 105 S.M.

Lanes | Date | o int [ vol. | Diff. | vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff.

9/5 516 516 | 0% | 521 | 1% | 515 | 0% - - - - - -

9/18 409 406 | -1% | 408 | 0% | 407 | 0% - - - - - -

NB1 10/1 404 402 | 0% | 404 | 0% | 402 | -1% | 405 | 0% - - - -

10/14 | 462 471 | 2% | 701 | 52% - - - - - - 471 | 2%

10/16 | 452 468 | 4% - - 438 | -3% - - 478 | 6% - -

9/5 526 525 | 0% | 513 | -2% | 509 | -3% - - - - - -

9/18 309 327 | 6% | 313 | 1% | 312 1% - - - - - -

NB2 10/1 328 355 | 8% | 330 | 1% | 331 | 0% | 330 1% - - - -

10/14 | 429 442 | 3% | 631 | 47% - - - - - - 496 | 16%

10/16 | 353 368 | 4% - - 349 | -1% - - 350 | -1% - -

9/5 220 228 | 4% | 220 | 0% | 235 | 7% - - - - - -

9/18 88 115 | 31% | 92 5% 111 | 26% - - - - - -

NB3 10/1 104 130 | 25% | 108 | 4% 126 | 17% | 108 | 4% - - - -

10/14 145 171 | 18% | 247 | 70% - - - - - - 141 | -3%

10/16 117 129 | 10% - - 123 | 5% - - 106 | -9% - -

9/5 415 403 | -3% | 407 | -2% | 429 | 3% - - - - - -

9/18 269 270 | 0% | 263 | -2% | 296 | 10% - - - - - -

SB1 10/1 316 322 | 2% | 318 | 1% | 329 | 2% | 322 | 2% - - - -

10/14 | 401 377 | 6% | 447 | 11% - - - - - - 494 | 23%

10/16 | 294 295 | 0% - - 289 | -2% - - 338 | 15% - -

9/5 643 661 | 3% | 645 | 0% | 629 | -2% - - - - - -

0 0 -
9/18 414 423 2% 415 0% 371 10%

SB2 | 10/1 | 430 | 434 | 1% | 419 | 3% | 398 | 6% | 425 | -1% | - - - -
1014 | 489 | 523 | 7% | 635 | 30% | - - - - - - | 615 | 26%
10/16 | 448 | 463 | 3% - - | 440 | 2% | - - | 433 | 3% | - -

9/5 247 249 | 1% | 253 | 2% | 252 | 2% - - - - - -

9/18 115 114 | -1% | 117 | 2% | 120 | 4% - - - - - -

sB3 | 101 | 114 | 117 | 3% | 119 | 4% | 123 | 6% | 116 | 2% | - - - -

10/14 153 140 | -8% | 219 | 43% - - - - - - 134

10/16 114 120 | 5% - - 124 | 9% - - 106 | -7% - -

Notes: S.M. refers to the sign-mounted configuration
The highlighted cells represent a difference of more than 5%

When the sensor volumes are aggregated by direction, the overall accuracy improved due to
the balancing of the under- and over-counted vehicles. Similar to the lane comparisons, the
SmartSensor HD had the best overall accuracy for the directional comparisons followed by the
RTMS and SmartSensor 105. Compared to manual counts, the inaccuracies of the
SmartSensor HD, RTMS, and SmartSensor 105 ranged from -1% to 1%, -1% to 3%, and 0% to
6%, respectively (Table 3).
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Table 3. Directional Sensor Volume Comparison

Manual SS 105 SS HD RTMS ATR SS HD S.M. | SS 105 S.M.
Lanes | Date

Count | vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff.

9/5 1,262 1,269 | 1% | 1,254 | -1% | 1,259 | 0% - - - - - -

9/18 806 848 | 5% | 813 1% 830 | 3% - - - - - -

NB 10/1 836 887 | 6% | 842 1% | 859 | 3% | 843 | 1% - - - -

10/14| 1,036 |1,084 | 5% |1,579 | 52% - - - - - - 1,108 | 7%

10/16 922 965 | 5% - - 910 | -1% - - 934 1% - -

9/5 1,305 11,313 | 1% |1,305| 0% | 1,310 | 0% - - - - - -

9/18 798 807 | 1% | 795 | 0% 787 | -1% - - - - - -

SB 10/1 860 873 | 2% | 856 | 0% | 850 | -1% | 863 | 0% - - - -

10/14 | 1,043 |1,040 | 0% |1,301 | 25% - - - - - - 1,243 |19%

10/16 856 878 | 3% - - 853 | 0% - - 878 3% - -

Notes: S.M. refers to the sign-mounted configuration
The highlighted cells represent a difference of more than 5%

A comparison of the total sensor volumes shows the SmartSensor HD to be the most accurate
of the three sensors, followed by the RTMS and the SmartSensor 105. Compared to manual
counts, the total volume inaccuracies of the SmartSensor HD, RTMS, and SmartSensor 105
ranged from 0%, -1% to 1%, and 1% to 4%, respectively (Table 4).

Table 4. Total Volume Comparison

Manual SS 105 SS HD RTMS ATR SS HD S.M. | SS 105 S.M.
Lanes Date

Count | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff. | Vol. | Diff.

9/5 2,567 (2,582 1% |2,559| 0% [2,569| 0% - - - - - -

9/18 1,604 |[1,655| 3% [1,608| 0% |1,617| 1% - - - - - -

Total 10/1 1,696 [1,760| 4% [1,698| 0% |1,709| 1% |1,706| 1% - - - -

10/14 | 2,079 |2,124| 2% |2,880 | 39% - - - - - - 2,351 | 13%

10/16 | 1,778 |1,843| 4% - - 1,763 | -1% - - 1,812 2% - -

Notes: S.M. refers to the sign-mounted configuration
The highlighted cells represent a difference of more than 5%

Traffic Speed

Speed data were recorded during each comparison study to illustrate the variation among the
sensors as previously discussed. It was difficult to calibrate the SmartSensor 105 to the hand-
held radar. Although the sensor speed values remained constant during some test days,
differences between the devices were 5 mph high on one day and 5 mph low on a different day.
Eventually the sensor was calibrated to within 3-4 mph for all lanes.

The SmartSensor HD has no parameters for calibrating speed data; however, speed calibration
was not needed. On every speed check comparison between the SmartSensor HD and the
hand-held radar, all lane’s speeds were within 2-3 mph. The RTMS speed calibration was an
easy process which required the user to manually enter the speeds taken from the hand-held
radar. The RTMS then adjusted the speed detection based on the observed values. Although
the speeds were initially calibrated to the hand-held radar, an issue was observed with the
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RTMS speed data. The two SmartSensors’ speed data are similar and realistic, but the RTMS
data was significantly different, which was high for close lanes and low for lanes further away
(Table 5).

Table 5. Sensor Speed Data (mph)

Date Lane SS 105 SS HD RTMS SSHD S.M. | SS 105 S.M.
NB 1 62 58 72 - -
® NB 2 63 60 54 - -
§ NB 3 65 64 57 - -
B SB 1 65 60 40 - -
@ SB 2 63 61 43 - -
SB3 65 65 45 - -
NB 1 62 59 73 - -
© NB 2 57 61 58 - -
3 NB 3 61 65 57 - -
s SB 1 62 59 42 - -
> SB2 60 60 44 - -
SB3 64 66 46 - -
NB 1 62 58 71 - -
© NB 2 58 60 56 - -
S NB 3 60 64 57 - :
g SB 1 64 60 41 - -
- SB 2 60 61 45 - -
SB3 63 65 46 - -
NB 1 62 - 72 61 -
8 NB 2 60 - 55 61 -
] NB 3 64 - 53 65 -
a SB 1 62 - 40 60 -
a SB 2 60 - 42 60 -
SB3 64 - 45 64 -
NB 1 63 - - - 65
2 NB 2 62 - - - 61
S NB 3 63 - - - 60
S SB1 63 - - - 62
S SB 2 61 - i i 61
SB 3 65 - - - 61

Note: S.M. refers to the sign-mounted configuration

Vehicle Classification

Since each sensor had different classification capabilities, and the SmartSensor 105 only had
the capability to classify 3 classes of vehicles, it was decided to group the classification into 3
major length bins: small (0-20 ft), medium (0-55 ft), and large (>55 ft). The classification aspect
of the data collection is the major limitation of each radar-based sensor. The SmartSensor 105,
was by far the least accurate of the three sensors. The SmartSensor 105 under-counted the
small vehicles and over-counted the medium and large vehicles (Table 6). The SmartSensor
HD slightly under-counted the small vehicles and slightly over-counted the large vehicles, while
over-counting the medium vehicles. The RTMS undercounted the small vehicles and over-
counted both the medium and large vehicles. The SmartSensor HD was consistently more
accurate than the other two, especially in classifying small vehicles.
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Table 6. Vehicle Length Classification Comparison

Small Vehicles

Volumes Difference
Lane Manual SS 105 SS HD RTMS SS 105 SS HD RTMS
NB 1 895 527 866 811 -41% -3% -9%
NB 2 599 271 579 485 -55% -3% -19%
NB 3 272 153 267 253 -44% -2% -7%
NB Total 1,766 950 1,712 1,549 -46% -3% -12%
SB 3 337 105 325 353 -69% -4% 5%
SB 2 910 253 889 678 -72% -2% -25%
SB 1 584 175 562 651 -70% -4% 11%
SB Total 1,831 532 1,776 1,682 -71% -3% -8%
Medium Vehicles
Volumes Difference
Lane Manual SS 105 SS HD RTMS SS 105 SS HD RTMS
NB 1 27 384 58 102 1,321% 115% 278%
NB 2 95 431 105 182 353% 11% 92%
NB 3 14 167 20 71 1,092% 43% 407%
NB Total 136 981 183 355 621% 35% 161%
SB 3 13 242 32 10 1,761% 146% -23%
SB 2 65 727 86 291 1,018% 32% 348%
SB 1 46 439 58 54 854% 26% 17%
SB Total 124 1,407 176 355 1,035% 42% 186%
Large Vehicles
Volumes Difference
Lane Manual SS 105 SS HD RTMS SS 105 SS HD RTMS
NB 1 3 11 5 9 260% 67% 200%
NB 2 141 150 142 140 6% 1% -1%
NB 3 22 23 25 22 4% 14% 0%
NB Total 166 183 172 171 10% 4% 3%
SB 3 12 16 13 33 32% 8% 175%
SB 2 82 103 85 67 26% 4% -18%
SB 1 54 59 50 20 9% -7% -63%
SB Total 148 178 148 120 20% 0% -19%
Total 4,171 4,232 4,167 4,232 1% 0% 1%

Note: Data from 3:30 — 4:30 PM on 9/5/08 and 10:30 — 11:30 AM on 9/18/08

A second classification comparison was conducted among the three radar sensors and the
ATR. The data from the ATR was provided by the NDDOT, and the classification performed by
the ATR is based on the Federal Highway Administration (FHWA) 15-vehicle classification

scheme. Because of this, the 15-vehicle classes were grouped into 3 classes for comparison
with the sensors: small (Class 1-4), medium (Class 5-7), large (Class 8-15).

The ATR had similar accuracy to the SmartSensor HD, however, the SmartSensor HD was

slightly better overall (Table 7). This may be due to the grouping of classification bins, but there

didn’t seem to be any consistency with the ATR’s data. The ATR over-counted some of the
lanes, and under-counted others in both the medium and large bins.
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Table 7. Vehicle Length Classification Comparison 10/1/08

Small Vehicles
Volumes Difference
Lane Manual | SS105 | SSHD | RTMS | ATR | SS105 | SSHD | RTMS | ATR
NB 1 384 166 344 315 383 -57% -10% -18% 0%
NB 2 207 81 197 155 213 -61% -5% -25% 3%
NB 3 81 55 80 70 86 -32% -1% -14% 6%
NB Total 672 302 621 540 682 -55% -8% -20% 1%
SB 3 97 24 97 109 102 -75% 0% 12% 5%
SB 2 325 42 309 177 330 -87% -5% -46% 2%
SB1 264 36 260 288 270 -86% -2% 9% 2%
SB Total 686 102 666 574 702 -85% -3% -16% 2%
Medium Vehicles
Volumes Difference
Lane Manual | SS105 | SSHD | RTMS | ATR | SS105 | SSHD | RTMS | ATR
NB 1 18 232 59 80 19 1,188% 228% 344% 6%
NB 2 63 195 62 104 31 209% -2% 65% -51%
NB 3 14 61 13 45 19 335% -71% 221% 36%
NB Total 95 488 134 229 69 413% 41% 141% | -27%
SB 3 12 82 16 9 4 583% 33% -25% | -67%
SB 2 53 329 54 169 34 520% 2% 219% | -36%
SB 1 35 255 39 36 25 628% 11% 3% -29%
SB Total 100 666 109 214 63 566% 9% 114% | -37%
Large Vehicles
Volumes % Difference
Lane Manual | SS105 | SSHD | RTMS | ATR | SS105 | SSHD | RTMS | ATR
NB 1 2 4 1 7 3 98% -50% 250% 50%
NB 2 61 79 71 72 86 29% 16% 18% 41%
NB 3 10 14 15 11 3 40% 50% 10% -70%
NB Total 73 97 87 90 92 33% 19% 23% 26%
SB 3 5 11 6 5 10 120% 20% 0% 100%
SB 2 52 63 56 52 61 21% 8% 0% 17%
SB 1 17 31 19 5 27 82% 12% -71% 59%
SB Total 74 105 81 62 98 41% 9% -16% 32%
Total 1,700 1,758 1,698 1,709 | 1,706 3% 0% 1% 0%

Sensor Mount Results

This study evaluated the use of sign-mounted sensors as an alternative to a dedicated mounting
system. This was done to determine if one type of mounting system was superior in terms of
volume accuracy. Both the SmartSensor 105 and SmartSensor HD were mounted on the sign,
and in both cases the accuracy of the sign-mounted configuration was slightly worse compared
to the tripod mounting system.
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Compared to manual counts on the same day, total volume inaccuracies of SmartSensor 105
using the tripod and sign-mount sytems were 2% and 13%, respectively. The accuracy of the
sign-mounted SmartSensor HD was better than the SmartSensor 105, but slightly less acurate
than the tripod-based SmartSensor HD. When compared to the manual volumes, total volume
inaccuracies of SmartSensor HD using the tripod and sign-mount sytems were 0% and 2%,
respectively.

The discrepancies between the two mounting systems could be attributed to the mounting
support. Since the sign post was the same offset at the tripod-bases, the mounting height of the
sensors remained the same. However, the height of the sign post was lower than the guy-wires
on the tripod bases, so there was slightly less stability for the sensors and an increased
possibility for sensor movement. Depending on the sign location and required height of the
sensor, this lack of support may not be an issue in all cases.

SUMMARY
This study evaluated three different radar-based sensors to determine their accuracy in

collecting vehicle volume, speed, and classification data. It also evaluated two types of sensor
mounting configurations to determine if they have a significant influence on sensor accuracy. In
addition, set up guides for the SmartSensor 105, SmartSensor HD, and RTMS are provided in
the appendices.

For the volume comparison, the SmartSensor HD showed a consistently higher accuracy over
the SmartSensor 105 and RTMS, except for the test when the sensor malfunctioned. The
SmartSensor HD had lane volume accuracies greater than 95%, directional volume accuracy of
at least 97%, and a minimum total volume accuracy of 98%. The accuracy of the SmartSensor
105 was within 69% for lane volumes, 81% for directional volumes, and 87% for total volumes.
The RTMS accuracy was within 74% for lane volumes, 97% for directional volumes, and 99%
for total volumes. The volume data from the ATR was also used in the comparison and
produced similar results as the SmartSensor HD (within 96% for lane volumes, 99% for
directional volumes, and 99% for total volumes).

Speed data compared during this study showed similar readings for both the SmartSensor 105
and SmartSensor HD, and significantly lower speed readings from the RTMS (except for one
lane). Although the speed calibration for the SmartSensor 105 was a tedious process, the
resulting speeds were relatively close to the manually recorded speeds (within 3-4 mph). The
SmartSensor HD did not require any type of speed calibration, and it consistently showed
speeds similar to the hand-held radar (within 2-3 mph). The speed calibration process for the
RTMS was easier than that of the SmartSensor 105, but the data was still inaccurate after
calibration and showed differences of up to 20 mph in some instances.

Vehicle classification seemed to be the most difficult task overall for all of the radar sensors.
Based on the data collected, the SmartSensor HD was the most accurate in classifying vehicles
and had accuracy ranges of (-2% to -4% for small vehicles, 11% to 115% for medium vehicles,
-7% to 67% for large vehicles), followed by the RTMS (-25% to 11% for small vehicles, -23% to
407% for medium vehicles, and -63% to 200% for large vehicles), and the SmartSensor 105
(-72% to -41% for small vehicles, 353% to 1761% for medium vehicles, and 4% to 260% for
large vehicles). In addition, the data from the ATR also showed some discrepancies when
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compared to manually collected data (0% to 6% for small vehicles, -67% to 36% for medium
vehicles, and -70% to 100% for large vehicles).

A comparison between the tripod-based mounting system and a sign-mounted configuration
was performed for both SmartSensor units. In both cases, the sensor’s accuracy on the tripod-
mounting system was slightly better. SmartSensor HD accuracy for lane volumes was within
95% (tripod mounted) and 85% (sigh mounted); directional volume was 99% (tripod mounted)
and 97% (sign mounted); and total volume was 100% (tripod mounted) and 98% (sign
mounted). The SmartSensor 105 accuracy for lane volumes was within 69% (tripod mounted)
and 74% (sign mounted); directional volume was within 94% (tripod mounted) and 81% (sign
mounted); and total volume was within 96% (tripod mounted) configuration, and 87% (sign
mounted).

Based on this study, the SmartSensor HD demonstrated the best overall performance, followed
by the RTMS. The SmartSensor 105 is a first-generation sensor, which has been replaced by
the SmartSensor HD, so its performance is understandably lower than the SmartSensor HD.
When compared with the inductive-loop ATR data collection system currently in place, the
SmartSensor HD showed comparable results. This illustrates the usefulness of using a radar-
based data collection system as a viable alternative to intrusive technologies, and can be
especially useful for temporary data collection.
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APPENDIX A:

SENSOR CONFIGURATION/CALIBRATION GUIDES



SmartSensor 105

Installation and Configuration

. Connect to sensor

a.
b.

C.
d.

Connect the SmartSensor cable to the battery using the positive and negative battery
terminals

Connect serial cable from SmartSensor cable to laptop COM port

Open the SmartSensor Manager 2.2.5 (SSMPC.07.04.27.exe) on the laptop

Connect using the serial connection

Il. Modify lane configuration

a.
b.

oo

From the “Edit” menu, select “Lane configuration”
Toggle mode to “Automatic”

w5
Click the “Restart” button: L=
Click OK on the warning that follows

Allow at least a few minutes for the SmartSensor to detect vehicles in each lane

Note: The lighter the traffic, the longer it will take for all of the lanes to be detected.

To make further adjustments, toggle to “Manual” mode

Manual configuration options include:

» Adjust Lanes — Adjusts existing lanes by moving shoulder, lane divider, or centerline.
Make sure centerlines (pink lines) are in the center of each driving lane.

Paint Lines —Inserts lane dividers in paved areas

Remove Lines — Removes a lane divider

Remove Lane — Removes one lane of a road

Construct Roads — Inserts a new road consisting of shoulder-center-shoulder
Remove Roads — Removes a road, including all lanes

Construct Barriers — Constructs a median or barrier

Remove Barriers — Removes a median or barrier

Reverse Direction — Reverses the direction of the lane. Initially all the lanes are
shown in the same direction. To display opposing traffic, reverse lane directions.
Edit Lane Names — Labels lane names for later identification of lanes on the Sensor
Info screen.

YV VVVVVVVYYVY

h. Once all desired lane modifications are made, click Update: ==

lll. Modify data collection parameters

a.
b.

From the “Edit” menu, select “Data collection parameters”

“General” tab settings:

» Sensor (Multi-drop) ID — changes ID number. The default is the last four numbers of
the serial number

RTMS ID - If the user chooses to communicate with the RTMS protocol, all that is
required is the RTMS ID

Description — Creates a description of the SmartSensor

Orientation — Provides a drop-down menu to specify which direction the
SmartSensor is facing. Mainly for benefit of the user

Measurement units — Provides a drop-down menu to specify unit of measurement

vV VYV V¥V

Page 1



» RF Channel — In case there are multiple SmartSensors in close proximity, the user
should assign each sensor a different RF Channel. This will reduce the interference
of the sensors with one another

c. “Communication” tab — Leave all settings on default unless otherwise known
d. “Data Collection” tab settings:

» Interval Data — specifies in seconds the interval time over which traffic date are
aggregated. The minimum interval allowed is 5 seconds

» Vehicle Classification — Specifies the length ranges for vehicle classes

» Lane Setup — Specify lane name and direction. “Scale Occupancy” and “Scale
Speed” columns are used when tuning the sensor. These factors are the ratio of lane
occupancy/speed to the default occupancy/speed.

» Default Loop Size and Spacing — If contact closure cards are being used, the cards
will read the Default Loop and Size and Spacing. These values are also used when
calculating the occupancy and speed scale factors.

IV. Sensor date & time
a. From the “Edit” menu, select “Sensor Date & Time”
b. Displays date and time of the sensor’s internal clock. Allows the user to manually
change the date and time or synchronize the sensor’s clock to PC clock by clicking:

Data Collection and Download

If the sensor will be deployed for an extended duration, change the battery prior to
downloading data.

Connect the SmartSensor cable to the battery using the positive and negative battery
terminals

Connect serial cable from SmartSensor cable to the laptop COM port.

Open the SmartSensor Manager (SSMPC.07.04.27.exe) on the laptop:

Connect using the serial connection option.

VVYV VYV V

Data Collection Setup

From the “Data Collection” menu, select “Setup”

Specify the desired interval (bin size) in seconds

Click “Start”

Click “OK” on the warning that all data stored onboard the sensor being erased
Allow a few moments for the data collection to begin

Click “OK” on the “View Interval and Buffer Status” window

0 Qo T

Data Download

From the “Data Collection” menu, select “Setup”
Choose a location to save the log file

Name and open the log file

Click “Download”

aeoo

Note: Download may take several minutes.

e. In order to continue data collection, you must begin a new study period: see Data
Collection. This erases the old data and starts collection of the new data.
f. From the “File” menu, choose “Close Connection” to end
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SmartSensor HD

Installation and Configuration

Connect to sensor

a. Connect the SmartSensor HD cable to the battery using the positive and negative
battery terminals

b. Connect serial cable from SmartSensor HD cable to laptop COM port

c. Open the SmartSensor HD Manager on the laptop

Connect using the serial connection. Ensure proper sensor alignment

a. On the main screen, click “Lane Setup”

b. Click “Sensor Alignment”

c. Adjust the sensor according to the sensor displayed in the “Sensor Alignment” window.
A green arrow means the sensor is positioned correctly for optimal performance; a
yellow or red arrow means the sensor in NOT correctly aligned with the roadway.

Lane configuration
a. Automatic configuration

1.

2.
3.

whh ke

From the main screen, select “Lane Setup” - "Lane Configuration”

Click the “Tools” icon S and select “Clear Edit Area”
Click the “Tools” icon again and select “Restart Auto Cfg.”

Note: This step could take several minutes depending on the
amount of traffic.

Once the SmartSensor HD has detected vehicles and created lanes, click “OK” and

save the changes to the configuration.

To verify that the lanes have been configured properly, close the “Lane

Configuration” window and select “Lane Verification” from the “Lane Setup” menu

If the sensor is unable to configure itself to your satisfaction, use manual

configuration.

b. Manual configuration

From the “Lane Setup” menu, select “Lane Configuration”

Click on a lane to change the lane name, lane direction, and lane activity

Uncheck the ‘Activity’ box to de-activate the lane

» Lanes can be adjusted by clicking anywhere inside the lane and using the
adjustment tools

Side bars on either side of the ‘Lane Configuration’ window have several different

modes. A list of the modes can be seen by holding down the sidebar button

» Auto Cfg. — shows the lanes that were automatically configured by the sensor

» Saved Cfg. — shows the lanes that are saved on the sensor

» Scale — shows the distance in feet from the SmartSensor HD to each lane

» Peaks — shows the relative occurrence of events

» Tracks — shows the vehicle paths for low-traffic lanes

Lanes can be added by clicking any area where a lane is desired and selecting “Add

Lane” from the options in the pop-up box

Deleting lanes can be done by clicking anywhere inside the lane and selecting

“Delete Lane” from the options that appear.
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IV.  Lane verification
1. From the “Lane Setup” menu, select “Lane Verification”
2. Side bars on either side of the “Lane Verification” window have several different
modes. A list of the modes can be seen by holding down the sidebar button
i.  Presence — displays buttons to the side of each lane that will light up after each
vehicle is detected
ii.  Volume — displays the number of events in each lane
iii. Speed — shows the speed of each individual car in their respective lanes

iv.-vii. Class — shows vehicle classification, which can be created using the ‘Class
Definitions’ feature located in the ‘Data Setup & Collection’ window

Data Collection and Download

a. If the sensor will be deployed for an extended duration, change the battery prior
to data download

b. Connect the SmartSensor cable to the battery using the positive and negative

battery terminals

Connect serial cable from SmartSensor to the laptop COM port

Open the SSM HD v.1.3 program on the laptop

oo

e. Connect to the sensor on the main screen by clicking:
f.  On the main screen, select “Data Setup and Collection”
g. Click “Data Collection & Download”->"Data Download”
i. Choose a location to save the log file
ii. Name the log file and open it
iii. After the download is finished, close the “Data Download” window
iv. Click “Storage Settings”
v. Click the eraser button to erase all the previous information
Note: Be sure that the data collection switch is turned to ‘ON’
vi. Close all windows to disconnect
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RTMS

Installation and Configuration

I. Connect to sensor
a. Connect the RTMS cable to the battery using the positive and negative battery terminals
b. Disconnect cable at the RTMS port that leads from the RTC Utility (Figure 1)
c. Connect RTMS cable from laptop COM port to RTMS data port in the RTC housing unit
(Figure 1)

| To Laptop
COM Port |

Figure L. RTMS COM Port Setup

II. Open the WinRtms program on the laptop

lll. Click the Setup Wizard for step-by-step setup

a. Specify RTMS mode of operation

b. Click OK

c. The Wizard will proceed to set sensitivity and initial zone setup

d. Resulting zone setup is presented for approval

e. Visually verify, using vehicle blips, whether zones were placed in all lanes of interest.
» If they are, click SKIP
» If not, click OK to manually change the number of zones and their location

IV. Click the SENSITIVITY button
a. Use up and down arrows to adjust sensitivity
b. Typical median value is 7
c. Seta value of 5 if only a few close lanes are being monitored
d. Increase sensitivity if needed to detect smaller vehicles in middle lanes of interest

Page 1



e.
f.

Do not increase sensitivity to compensate for improper alignment
Click OK when finished

V. If vehicles are inaccurately detected as a result of large trucks (splashing), click FINETUNE

a.
b.

C.

If first and last zones are well defined, the Auto fine tuning can be used

For manual fine tuning, set the initial value to 0, then use the up and down arrows to

visually verify that a decrease in splashing effect is taking place

» A splash occurring nearer to the sensor is corrected by increasing the fine tune value

» A splash occurring farther from the sensor is corrected by decreasing the fine tune
value

Click OK

VI. Click PERIOD to set the length of data collection interval, in seconds

a.
b.

VII.

a.
b.
C.

d.

-

~o o

g.

Use up and down arrows to adjust the message period (interval) length
Click OK

Verify the accuracy of the vehicle detection

Select PERIOD and set to 30 seconds

Select VERIFY from the main screen
When the left-side window appears, tap the spacebar to checkmark the CLEAR TOTAL
COUNTERS ON NEXT MESSAGE INTERVAL box and get ready to start counting
At the end of the current message period, the background window blinks and the
program emits a beep, signaling to start the manual count

Count vehicles in the selected lanes as they cross the RTMS beam
At the end of the message period the RTMS updates the detected vehicle counts for that
period
Tap the space bar and this will checkmark the STOP COUNTING box and freeze the
RTMS count

» Enter the manual count to display the absolute difference and the percent deviation

between the manual and RTMS counts

» Deviation beyond approximately +5% may require fine tuning or sensitivity correction
Click SAVE to save results of verification as a text file

Click OK

Click SPEED CALIB to calibrate the vehicle speeds
Click automatic speed calibration
Input reference speed for all lanes
» Reference speed for each lane is the average speed and should be determined
using radar speed detection
» Insert an X to exclude a lane from calibration
Enter the number of calibration cycles when OFF is highlighted by using the up and
down arrows. CALIBRATION IN PROCESS will flash
Hint: It is better to reduce the period to 30 seconds so there are more cycles. 7
cycles of 30 seconds is recommended.
The setup utility adjusts all active zone coefficients to converge the reference speeds
If traffic flow changes during calibration , adjust the reference speeds as appropriate
When finished, set the number of calibration cycles to OFF
Click QUIT

IX. Click the SENSOR ID to specify a sensor ID number

X. Click DATA MODE to specify data parameters

a.

Select MESSAGE COMPOSITION to open the RTMS Statistical message window
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High resolution occupancy provides occupancy measurements with 0.1% resolution
instead of the default 1% resolution

6 foot emulation adjusts occupancy measurements to be equivalent to the 6 foot loop
data

The number of vehicle classes can be specified to be 2, 4, or 6

Toggle the REAL TIME CLOCK button to sync data collection with computer clock.
Click OK

VVYV VYV 'V

Xl. Advanced parameters can be specified by clickihg ADVANCED

coow

g.
XIl

EXTENSION DELAY allows the user to change the Mode default

DETECTION THRESHOLD allows the user to change the threshold from default

KM/H — MPH allows the user to convert recorded speeds from the default km/h to mph

LONG VEH/HEADWAY allows users to select either Long Vehicles or Headway as

required

SPEED BINS specifies ranges of speed for data collection

» Specify bin’'s upper speed limit

» Upper limit of a bin automatically defines the lower limit of the next bin

POWER MANAGEMENT allows RTMS powered by battery to be operated in cycles to

conserve battery power

» “Number of cycles on” defines the number of message periods the sensor operates

» “Standby in minutes” defines the number of minutes the sensor is in standby and
draws minimum power. Max time is 4 hours, 14 minutes

CLASSIFICATION allows the user to set the lower limit of the vehicle classes

. Click Exit to exit the RTMS

XIIl. Disconnect the RTMS cable between the laptop and RTMS data port and reconnect

cable from the RTC to the RTMS.

Data Collection and Download

If the sensor will be deployed for an extended duration, change the battery prior to data
download

Connect serial cable from laptop to the available port in RTC housing unit (Figure 2)
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To Laptop
7| COM Port

k. e ce— J
Figure 2. RTMS Data Download

lll. Open the RTC Utility program on the laptop

IV. Click DOWNLOAD

V. Choose a location to save the log file

VI. Name the file and click SAVE

VII. After download is complete, click CLEAR RTC MEMORY to erase all data

VIII. Close RTC Utility
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